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Лабораторная работа № 8 Программирование промышленных микроконтроллеров 

 

Цель работы: изучение графической среды программирования Labview, основ 

построения моделей средств измерений; получение простейших навыков работы с 

виртуальными приборами.  

 

8.1 Общие сведения о Labview 

 

Прежде чем вы приступите к изучению пакета, возможно, вам будет интересно узнать, 

что такое Labview, что вы можете с ним делать и что он может сделать для вас. 

Labview (Laboratory Virtual Instrument Engineering Workbench) - среда разработки 

лабораторных виртуальных приборов) является средой программирования, с помощью 

которой вы можете создавать приложения, используя графическое представление всех 

элементов алгоритма, что отличает ее от обычных языков программирования, таких как С, 

C++ или Java, где программируют, используя текст. Однако Labview представляет собой 

значительно большее, чем просто алгоритмический язык. Это среда разработки и исполнения 

приложений, предназначенная для исследователей - ученых и инженеров, для которых 

программирование является лишь частью работы. Labview функционирует на компьютерах, 

работающих под управлением всех распространенных операционных систем: Windows, 

MacOS, Linux, Solaris и HP-UX. 

Мощный графический язык программирования Labview позволяет в сотни раз увеличить 

производительность труда. Создание законченного приложения с помощью обычных языков 

программирования может отнять очень много времени - недели или месяцы, тогда как с 

Labview требуется лишь несколько часов, поскольку пакет специально разработан для 

программирования различных измерений, анализа данных и оформления результатов. Так 

как Labview имеет гибкий графический интерфейс и прост для программирования, он также 

отлично подходит для моделирования процессов, презентации идей, создания приложений 

общего характера и просто для обучения современному программированию. 

Измерительная система, созданная в Labview, имеет большую гибкость по сравнению со 

стандартным лабораторным прибором, потому что она использует многообразие 

возможностей современного программного обеспечения. И именно вы, а не изготовитель 

оборудования, определяете функциональность создаваемого прибора. Ваш компьютер, 

снабженный встраиваемой измерительно-управляющей аппаратной частью, и Labview 

составляют полностью настраиваемый виртуальный прибор для выполнения поставленных 

задач. С помощью Labview допустимо создать неооходимый тип виртуального прибора при 

очень малых затратах по сравнению с обычными инструментами. При необходимости вы 

можете внести в него изменения буквально за минуты. Labview создан для облегчения 

работы по программированию ваших задач. Для этой цели имеется расширенная библиотека 

функций и готовых к использованию подпрограмм, которые реализуют большое число 

типичных задач программирования и тем самым избавляют вас от рутинной возни с 

указателями, распределением памяти и прочего шаманства, присущего традиционным 

языкам программирования. В Labview также содержатся специальные библиотеки вир-

туальных приборов для ввода/вывода данных со встраиваемых аппаратных средств (data 

acquisition - DAQ), для работы с каналом общего пользования (КОП, General Purposes 

Interface Bus - GPIB), управления устройствами через последовательный порт RS-232, 

программные компоненты для анализа, представления 

В Labview используется терминология, рисунки иконок и основные идеи, знакомые 

ученым и инженерам. Этот язык базируется на графических символах, а не на тексте для 

описания программируемых действий. Основополагающий для Labview принцип потока 

данных (dataflow), согласно которому функции выполняются лишь тогда, когда они 

получают на вход необходимые данные, однозначно определяет порядок исполнения 
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алгоритма. Вы можете освоить Labview при небольшом или даже отсутствующем опыте 

традиционного программирования, хотя знание его принципов было бы весьма полезным. 

 

 

8.2 Основные понятия и правила построения виртуальных приборов 

 

Программа, написанная в среде Labview, называется виртуальным прибором (ВП). ВП 

симулируют реальные физические приборы. Labview содержит полный набор инструментов 

для сбора, анализа, представления и хранения данных. Запуск среды программирования 

Labview осуществляется либо двойным кликом мыши на ярлыке Labview, который 

находится на рабочем столе, либо из раздела Пуск - Программы - National Instruments 

Labview. При входе в главное меню Labview пользователю предлагается создание нового 

виртуального инструмента (New VI) или открытие уже существующего (Open VI). 

Виртуальный прибор состоит из трех основных частей: 

- лицевая панель (Front Panel) представляет собой интерактивный пользовательский 

интерфейс виртуального прибора и названа так потому, что имитирует лицевую панель 

традиционного прибора. На ней могут находиться ручки управления, кнопки, графические 

индикаторы и другие элементы управления (controls), которые являются средствами ввода 

данных со стороны пользователя, и элементы индикации (indicators) - выходные данные из 

программы. Пользователь вводит данные, используя мышь и клавиатуру, а затем видит 

результаты действия программы на экране монитора; 

- блок-диаграмма (Block Diagram) является исходным программным кодом ВП, 

созданным на языке графического программирования Labview, G (Джей). Блок-диаграмма 

представляет собой реально исполняемое приложение. Компонентами блок-диаграммы 

являются: виртуальные приборы более низкого уровня, встроенные функции Labview, 

константы и структуры управления выполнением программы. Для того чтобы задать поток 

данных между определенными объектами или, что то же самое, создать связь между ними, 

вы должны нарисовать соответствующие проводники (wires). Объекты на лицевой панели 

представлены на блок-диаграмме в виде соответствующих терминалов (terminals), через 

которые данные могут поступать от пользователя в программу и обратно; 

- иконки и соединительная панель. Для того чтобы использовать некоторый ВП в 

качестве подпрограммы (подприбора) в блок-диаграмме другого ВП, необходимо определить 

его иконку (icon) и соединительную панель (connector). Виртуальный прибор, который 

применяется внутри другого ВП, называется виртуальным подприбором (ВПП, SubVI), 

который аналогичен подпрограмме в традиционных алгоритмических языках. Иконка 

является однозначным графическим представлением ВП и может использоваться в качестве 

объекта на блок-диаграмме другого ВП. Соединительная панель представляет собой 

механизм передачи данных в ВП из другой блок-диаграммы, когда он применяется в 

качестве подприбора - ВПП. Подобно аргументам и параметрам подпрограммы, 

соединительная панель определяет входные и выходные данные виртуального прибора. 

Разработка VI (ВП) осуществляется на двух панелях, находящихся в двух окнах, - 

передней (лицевая панель) и функциональной (блок-диаграмма). Лицевая панель - интерфейс 

пользователя создается с использованием палитры Элементов (Controls). Эти элементы 

могут быть либо средствами ввода данных - элементы управления, либо средствами 

отображения данных - элементы отображения. Элементы управления - кнопки, 

переключатели, ползунки и другие элементы ввода. Элементы отображения - графики, 

цифровые табло, светодиоды и т.д. 

После этого на блок-диаграмме ВП осуществляется программирование с использованием 

палитры Функций (Functions), которая включает графическое представление функций для 

управления объектами на лицевой панели. 
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Структура панелей одинакова. Основным элементом каждой панели является рабочая 

область, снабженная горизонтальным и вертикальным скролингами, в которой и размеща-

ются элементы. Также на панелях имеются верхнее меню и набор управляющих кнопок: 

- кнопка «стрелка» - пуск выполнения программы; если в программе имеются ошибки, то 

данная кнопка расколота на две части; 

- кнопка «стрелки в цикле» - запуск программы в циклическом режиме;  

- кнопка «красный круг» - остановка выполнения программы;  

- кнопка «две вертикальные черты» - пауза в выполнении программы. 

  

 
 

Рисунок 8.1 – Управляющие кнопки 

 

Для обеих панелей доступна панель Tools Palette (рисунок 8.2), включающая набор 

управляющих кнопок для изменения режима редактирования: 

- кнопка «указательный палец» служит для изменения позиций выключателей и кнопок, 

управления значениями цифровых регуляторов, настройки виртуальных осциллографов и 

др.; 

-  кнопка «стрелка» - выделение, перемещение объектов, изменение их размера; 

- кнопка «катушка» служит для соединения объектов на функциональной панели; 

- кнопка «кисть» - раскрашивание объектов или фона; 

- кнопка «рука» - перемещение рабочей области панели в окне; 

- кнопка «пипетка» - выбор текущего цвета из имеющихся на панели; 

- кнопка «красный круг» - для размещения и снятия точек остановки выполнения 

программы на функциональной панели; 

- кнопка «Р» - для размещения на функциональной панели локальных окон для 

отображения текущих значений данных, передаваемых в ходе выполнения программы. 

 

 
 

Рисунок 8.2 - Панель Tools Palette 

 

При активной передней панели становится доступной панель Controls (рисунок 8.3), 

которая вызывается либо щелчком правой кнопки мыши в рабочем пространстве лицевой 

панели, либо необходимо выбрать в пункте главного меню Window - Show Controls Palette. С 

ее помощью осуществляется визуальное размещение элементов управления и элементов 

отображения на лицевой панели ВП. В панели Controls они распределены по отдельным 

группам по некоторым признакам - числовые, логические, строковые, массивы, диалоговые, 

ActivX, Internet и др. 
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Рисунок 8.3 - Панель Controls 

 

Рассмотрим основные подпанели панели Controls: 

- Numeric (числовые значения). Состоит из элементов управления и элементов 

отображения для числовых данных; 

- Boolean (булевы значения). Состоит из элементов управления и элементов отображения 

для булевых величин; 

- String&Table (строковые значения и таблицы). Состоит из элементов управления и 

элементов отображения для ASCII строк и таблиц; 

- List & Ring (списки и закольцованные списки). Состоит из элементов управления и 

элементов отображения для меню, выполненных в форме списков и закольцованных 

списков; 

 - Array & Cluster (массивы и кластеры). Состоит из элементов управления и элементов 

отображения для группировки наборов типов данных; 

 - Graph (виртуальные осциллографы). Состоит из элементов отображения для 

построения графиков данных в графах или диаграммах в реальном масштабе времени; 

 - Path & Refnum (пути и ссылки). Состоит из элементов управления и элементов 

отображения для путей и ссылок; 

 - Decorations (оформление). Состоит из элементов управления и элементов отображения 

графических объектов для настройки дисплеев лицевой панели; 

 - Select Control (выбор регулятора). Отображает диалоговое окно для загрузки 

самодельных элементов управления; 

 - User Controls (средства управления пользователя). Состоит из специальных средств 

управления, которые формирует сам пользователь; 

 - ActiveX (объекты ActiveX). Состоит из средств управления, позволяющих внедрить 

объекты ActiveX на лицевую панель; 

 - Dialog (диалоговая панель). Состоит из стандартных объектов для формирования 

диалога с пользователем; 

 - IMAQ Vision (обработка изображений). Состоит из средств обработки и анализа 

изображений; 

 - Internet Toolkit (работа с Internet). Состоит из средств управления, располагаемых на 

передней панели, позволяющих организовывать работу виртуальных инструментов в сети 

Internet (ftp, электронная почта, telnet, CGI и другие). 

После помещения элементов управления или отображения данных на лицевую панель 

они получают свое графическое отображение (в виде терминала данных) на блок-диаграмме. 

Символы на терминале соответствуют типу данных терминала. Например, DBL – терминал 

представляет данные в виде вещественных чисел с двойной точностью, TF – логический 

терминал, I16 – терминал 16-битных целых и др. 
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При активировании функциональной панели становится доступной палитра Functions 

(рисунок 8.4), которая аналогично панели Controls включает систематизированные наборы 

стандартных элементов в виде отдельных пиктограмм, из которых осуществляется 

составление блок-схемы ВП. Палитра Functions вызывается либо щелчком правой кнопки 

мыши в рабочем пространстве блок-схемы, либо путем выбора в пункте главного меню 

Window - Show Function Palette. 

 

 
 

Рисунок 8.4 – Панель Functions 

 

Рассмотрим основные подпанели панели Functions: 

- Structures (структуры). Состоит из управляющих структур программы, таких как циклы 

For Loop, While Loop и др.; 

- Numeric (числовые функции). Состоит из тригонометрических, логарифмических и 

других функций; 

- Boolean (булевы функции). Состоит из логических и булевых функций; 

- String (строковые функции). Состоит из функций для работы со строковыми 

величинами; 

- Array (массивы). Состоит из функций для обработки массивов; 

- Cluster (кластеры). Состоит из функций для обработки кластеров; 

- Comparison (сравнение). Состоит из функций для сравнения переменных; 

- Time & Dialog (время и диалог). Состоит из функций для диалоговых окон, 

синхронизации и обработки ошибок; 

- File I/O (ввода/вывода файла). Состоит из функций для осуществления операций по 

вво-ду/выводу файлов; 

- Instrument I/O (инструменты ввода/вывода). Состоит из ВП для связи и управления 

прибо-рами различной архитектуры; 

- Instrument Drivers (драйверы приборов). Состоит из ВП, способных управлять 

внешними приборами, осциллоскопами, генераторами и т.д., через последовательный порт 

или интерфейс GPIB; 

- Graphics & Sound (графика и звук). Состоит из ВП для работы с трехмерной графикой, 

изображениями и звуком; Communication (связи). Состоит из виртуальных приборов для 

работы с сетями TCP, DDE и др.;  
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- Application Control (управление приложением). Состоит из ВП, управляющих 

виртуальными приборами; Advanced (расширенная). Состоит из разных функций типа 

функции библиотечного запроса, манипуляции данных и 

- Data Acquisition (сбор данных). Состоит из ВП для использования плат сбора данных; 

- Signal Processing (обработка сигналов). Состоит из ВП для генерации и обработки 

сигналов; 

- Mathematics (математические). Состоит из оптимизационных, алгебраических, 

интегральных, дифференциальных и других функций; 

- Report Generation (генерация отчета). Состоит из ВП, используемых для подготовки 

отчетных документов; Tutorial (обучающие программы). Состоит из ВП, используемых в 

обучающей программе LabVIEW;  

- User Libraries (пользовательские библиотеки). С помощью нее организуется быстрый 

доступ к нужному vi; Select VI (выбор ВП). Состоит из диалогового окна для внедрения 

подпрограмм в текущий ВП;  

- IMAQ Vision (обработка изображений). Состоит из ВП, используемых для обработки и 

анализа изображений;  

- Image Acquisition (получение изображения). Состоит из ВП, используемых для 

получения и обработки изображений; Internet Toolkit (работа с Internet). Состоит из ВП, 

используемых для работы в сети Internet (ftp, электронная почта, telnet, CGI и др.); 

- SQL (SQL запросы). Состоит из ВП, используемых для организации связи с SQL 

сервером и обработки запросов. 

Объекты блок-диаграммы включают графическое отображение элементов лицевой 

панели, операторов, функций, подпрограмм ВП, констант, структур и проводников данных, 

по которым производится обмен данными между объектами блок-диаграммы. 

Проводники данных между терминалами аналогичны переменным на обычных языках. 

Данные идут в только одном направлении, с исходного терминала на один или более 

терминалов адресата. Провода имеют различную толщину и цвет. Синий цвет соответствует 

целым числам, оранжевый – вещественным числам, зеленый – логическим, лиловый – 

строковым данным и т.д. 

При нажатии правой кнопки мыши на регуляторе/индикаторе (как на передней, так и на 

функциональной панели) появляется контекстное меню, с помощью которого возможно 

осуществить: 

- замену элемента управления (регулятора) на элемент отображения (индикатора) и 

наоборот (Change to Control, Change to Indicator); 

- быстрый поиск терминала на функциональной панели (Find Terminal) и 

регулятора/индикатора на передней панели (Find Control, Find Indicator); 

- демонстрацию или отказ от названия для описания регулятора/индикатора (Show → 

Label, Show → Caption); 

- настройку параметров регулятора/индикатора (Data Operations); 

- замену на другой регулятор/индикатор (Replace); 

- получение справки по используемой функции (Online Help); 

- открытие для функций соответствующих им констант, индикаторов и регуляторов (Create 

Constant, Create Indicator, Create Control). 

 

 

Порядок выполнения работы 

 

1. Изучить материал о программе Labview 8.5. 

2. Изучить палитры блок – диаграммы и лицевой панели. 

3. Выполнить задание. 

4. Ответить на контрольные вопросы. 
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Задания: 

1. Запустите Labview Пуск → Программы → NationaI Instruments → Labview 8.5 → 

Labview. Появится диалоговое окно Labview. 

2. Выберите Help → Find Examples. На экране появится диалоговое окно поиска 

примеров ВП, разбитых по категориям. 

3. Перейдите на закладку Browse (Обзор). Отметьте пункт Directory Structure. Выберите 

Apps, Freqresp.Ilb и дважды щелкните на Frequency Response.VI (Частотная характеристика). 

Появится лицевая панель ВП «Частотный анализ» (рисунок 8.5). 

 

 
 

Рисунок 8.5 – Виртуальный прибор «Частотный анализ» 

 

4. С помощью инструмента УПРАВЛЕНИЕ измените значение установки амплитуды 

Amplitude. Изменить значение можно либо переместив указатель кнопки в нужное 

положение, либо используя стрелки изменения значений элемента управления, либо введя 

число непосредственно в дисплей элемента. 

Если число введено непосредственно в дисплей элемента, то необходимо нажать кнопку 

Enter, показанную слева, появившуюся на инструментальной панели. Иначе число не будет 

введено. 

5. Нажать кнопку Run и запустить ВП. Изменяя значения других средств управления, 

находящихся на панели, исследовать работу ВП. 

6. Перейдите на блок-диаграмму. Для этого выберите в главном меню Window -> Show 

Diagram или введите Ctrl-E с клавиатуры. 

7. Откройте окно контекстной справки, выбрав в пункте главного меню Help → Show 

Context Help. Получить информацию об объекте в окне контекстной справки Context Help 

можно, наведя на них курсор: 

а) Поместите инструмент ПЕРЕМЕЩЕНИЕ над функцией Logarithm Base 10, 

расположенной под меткой Bode Plot. В окне контекстной справки Context Help появится 

описание функции; 

б) В окне контекстной справки Context Help нажмите кнопку More Help для перехода в 

соответствующий раздел Labview Help (Встроенной Помощи). Можно также щелкнуть по 

ссылке Click here for more help окна контекстной справки Context Help. 

Labview Help (Встроенная Помощь) содержит подробное описание палитр, меню, 

инструментов, ВП и функций. Здесь можно получить подробное описание и других функций; 

в) Наведите инструмент СОЕДИНЕНИЕ на поля ввода/вывода данных функции 

Logarithm Base 10. Соответствующие поля в окне контекстной справки Context Help начнут 

мигать; 

г) Переместите инструмент СОЕДИНЕНИЕ на проводник данных. В окне контекстной 

справки Context Help появится описание типа данных в проводнике. 
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8. Чтобы зафиксировать текущее окно Context Help (контекстной справки), необходимо 

выбрать в пункте главного меню Help → Lock Context Help. Когда текущее окно Context Help 

(контекстной справки) зафиксировано, то его содержимое не меняется после наведения 

курсора на другой объект.  

 

 

Содержание отчета 

1. Титульный лист; 

2. Наименование, цель и задание к лабораторной работе; 

3. Выводы о проделанной работе; 

4. Демонстрация выполненного задания на ПК; 

5. Ответы на контрольные вопросы. 

 

 

Контрольные вопросы 

1. Из каких основных компонентов состоит ВП? 

2. Что понимается под интерфейсом пользователя ВП? 

3. Какие палитры доступны для лицевой панели? 

4. Какие палитры доступны для блок-диаграммы? 

5. Что представляет собой лицевая панель? 

6. Каково назначение блок-диаграммы? 

7. Из каких подпалитр состоит палитра Controls (Элементов)? 

8. Из каких подпалитр состоит палитра Functions (Функций)? 

9. На каких панелях осуществляется разработка ВП? 

10. Назовите назначение управляющих кнопок на блок-диаграмме. 

11. Назовите назначение управляющих кнопок на лицевой панели. 

12. Что такое элемент управления и элемент отображения? 

13. Назовите основные типы данных. 

14. Что такое проводник данных? 

15. Каким образом осуществляется вызов контекстной справки? 

16. Как можно зафиксировать текущее окно контекстной справки? 

17. Назовите назначение контекстного меню. 
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